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1.  STARTING

1.1 Contents of CD-ROMs
CD-ROMs are organized into four different product groups:

Each CD-ROM covers various product families, as follows:

DVD-Roms are organized as follows: 
The Global Infotech DVD-Rom contains all of the parts catalogues for the four different product groups (Garden, Industrial, Marine, Motors). 
The Infotech Documentation System DVD-Rom contains all of the documents other than the parts catalogues as well as the Infotech Documentation System 
software.

Group N° Group CD-ROM concerned
1 Garden 1a, 1b, 1c, 1d, 1-1, 1-2
2 Industry 2, 2-1, 2-2
3 Marine 3, 3-1
4 Motors 4, 4-1

CD-Rom N° Type Families covered
1a Parts catalogue Lawnmowers, Brushcutters on wheels, Carried brushcutters
1b Parts catalogue Riding lawnmowers, Front-cutting lawnmowers, Tractors
1c Parts catalogue Tillers
1d Parts catalogue Snowthrowers
1-1 Documents Lawnmowers, Brushcutters on wheels, Carried brushcutters, Riding lawnmowers,

Front-cutting lawnmowers, Tractors, Tillers, Snowthrowers1-2 Documents
2 Parts catalogue

Generator sets, Motor-driven pumps, Caterpillar track power carriers2-1 Documents
2-2 Documents
3 Parts catalogue

Outboard motors
3-1 Documents
4 Parts catalogue

Motors
4-1 Documents
2



Honda Global Infotech 

1.2 Starting Honda Global Infotech

From the "Start", click on the "Infotech" icon. 
A "Honda The Power of Dreams" welcome screen is displayed for about two seconds. 
Then the product family selection window is displayed.

1.3 Identifying product families
CD-ROM ICON FAMILY ICON FAMILY ICON FAMILY

1A LAWNMOWERS BRUSHCUTTERS
ON WHEELS

CARRIED
BRUSHCUTTERS

1B RIDING
LAWNMOWERS

FRONT-CUTTING
LAWNMOWERS

TRACTORS

1C TILLERS

1D SNOWTHROWERS

2 GENERATOR
SETS WATER PUMPS CATERPILLAR TRACK

CARRIERS

3 OUTBOARD
MOTORS

4 MOTORS
3
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1.4  Global Infotech toolbar

Previous page

Next page

Zoom in

Original size

Zoom out Search for a part by its name

List of manuals, handbooks and circulars

Direct access to workshop manual

Access code

Print

Return to welcome screen

Previous screen

Ordering mode

Load an order

Search for a part by its part number

Change current selection

Type variation tables

Part information

Language settings
4
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1.5 Menu bar

1.5.1 “File” menu
 
Print: to print the whole page (drawing, F.R.T, parts list), the drawing only, or the parts list only. 
Finish: to quit Global Infotech.

 

1.5.2 Menu "Ajustements"
 
Order Form: opens the "order form" dialogue box. 
Ordering: switches to ordering mode. 
Language: changes the language for data and/or the program interface. 
Logo: indicates the path to the image representing the logo to be printed on Order Forms and Estimates. 
Copy Catalog: copies the parts catalogues on the DVD to your hard disk drive (refer to the Installation Manual). 
VAT code: lets you enter the VAT code that will be printed on your estimates and invoices.

 

1.5.3 “View” menu
Toolbar: hides or shows the toolbar. 
Order: hides or displays the status bar. 
Standard service: resets the layout of the windows in the active screen or in all screens.
Note: This function is useful when you have used the “Maximize” function in the context menu. (See section 2.2.4).

 

1.5.4 "Help" menu
Directions for use: opens the directions on how to use Global Infotech (Acrobat document). 
Introduction: opens the general introduction to parts catalogues (Acrobat document).
5
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2.  SPARE PARTS CATALOGUE 

2.1 Select one or more machines 
Before you can display a parts catalogue, you have to select one or more machines. To help you do this, Global Infotech provides many very useful functions.

1. Click on the icon for the family containing the model you are looking for (See table in section 1.3). 
The models/types selection window appears above the families selection window. (See illustration below). 

 

 

 

Main model selection 
window

Honda reference of corresponding 
parts catalogue

Filters

Models/types selection 
window

Field containing additional informa-
tion on the Model/Type selected. 

Note: This is only visible if only one 
model/type has been selected

Optional catalogue selection window.

Note: This window is only visible if there 
is more than one parts catalogue for the 
main model selected

Click here to cancel everything and 
return to the families selection screen

View all the models/types available in 
the catalogue

Select all the models/types visible in the 
left-hand window

Enter, here, the chassis serial number 
for your machine (optional)

Enter, here, the motor serial number for 
your machine (optional)

Click here to validate your selection
6
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2. First select a model in the main model selection window (See page 6). 

If the model selected appears in more than one parts catalogue, a new window is displayed to the right. Select the model you require in that window. 
Note: You only select one model in this window.

3. Now select the desired models/types in the models/types selection window.  
Note: If you want to select more than one model/type, hold down the "Control" key on your keyboard and click on the lines to be selected.

 
Several tools are provided to help you find your model/type:
- Filters: Click on the button in the dropdown menu and choose the filter criterion. Only models/types matching that criterion will be displayed in the 

models/types window.

- Serial numbers: These fields can be used to find the model and type of a machine ver quickly when you have its motor and/or chassis serial numbers.

 Note: You can combine filters and serial numbers to obtain a more accurate result.

4. Validate your choice by clicking on the "OK" button. 
The parts catalogue navigation screen is displayed. The left half contains the table of contents of the parts catalogue and the right half shows thumbnail 
views of the group selected.
7
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IMPORTANT: In Global Infotech, when a text is displayed in blue, this means you can click on it.

Thumbnail views: 
Click on a view to go to the 
corresponding page in the 
catalogue.

Photos of models: 
Click on the blue text to 
display the corresponding 
image

Contents:
1st column:

•  Click on button:  
to display thumbnail views in 
full-screen return to this 
screen, press themode. Then, 
to "Previous screen" button in 
the toolbar. (See section 1.4).

•  Click on button 
to display the corresponding 
thumbnail views in the right-
hand part of the screen.

2nd column: Block number.
3rd column: block title 
Click on the blue text to go to 
the corresponding page in the 
parts catalogue.
8
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5. Click on the name of the block or on its thumbnail view to go to the corresponding page of the parts catalogue.

Repair time 
(F.R.T.): 
Note: You can copy the 
contents of the table or one 
of its lines and then paste in 
anther document (such as in 
a Word or Excel document, 
or as a note in an estimate - 
See section 4.7).

Assembly drawing:
Note: When the mose 
is placed over a part 
number, the 
corresponding part 
numbers are 
overscored in black.

Parts list:
Note: When the 
mouse is placed over 
a line, it is overscored 
in black, as is the 
corresponding part 
number in the 
drawing.
Note: Click on the blue 
button to display the 
types concerned.
9
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2.2 Parts catalogue tool

2.2.1 Moving

Use the "next page" and "previous page" buttons to move from one block to another. 

If you want to go to a block that is further away, it is preferable to return to the catalogue navigation screen. (See page 8).

2.2.2 Magnifying and reducing a drawing
To magnify part of the image, click on the "Zoom" button. Click and hold down the left mouse button and then drag with the mouse to frame the area to
be magnified. Then release the mouse button.

Click on this button to fit the image to the size of the frame.

Click on this button to fit the image to the width of the frame. 

2.2.3 Changing the selected model / type
Click on the "Model" button. The models / types selection window appears. Proceed as described in section 2.1 to select another model / type. When 
you have validated your selection, you return directly to the block you were on.

2.2.4 Printing a block

 Click on this button to print a block. A new window is displayed, asking you to specify the type of printout you require:
10
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2.2.5 Context menu

The context menu is displayed when you click the right mouse button. The contents of this menu vary according to where you click.

2.2.6 Information on parts
The Part information dialogue box is used to order a part, obtain its price and access personal notes.

Copy all or part of the contents of the 
selected window onto the clipboard.

Selected part display 
window.

Price of part.

Button to access 
personal notes.

Click here to add the part to 
the current order.

Displays the information window 
for the selected part.

Zoom functions (See section 2.2.2).

Adds the selected part to the order.

Maximizes the window to full-screen mode.

Opens the order form.

Click here to close the window and return to the parts catalogue.

If you want to order this 
part, enter the quantity 
to be ordered here.

Discount group.

VAT rate.
11
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Personal notes:

- Add a note: 
Click on the "Notes" button in the "Part information" dialogue box. A new window opens and you can use it to enter your note. When you have finished, 
save your note by selecting "Save" in the "File" menu. 
The note will then be saved on your hard disk, in directory "\Infotech\Notizen\Teile". The file name of the note will be the relevant part number. 
It is possible to swap notes between several computers equipped with Infotech. All you have to do is directly copy the files contained in the "Teile" 
directory. 

- Consult a note: 
Click on the notes access button in the "Part information" dialogue box. When a note is available, the button icon is read.

Note not available 

Note available
12
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2.3 Part search functions
You can search for a part by its part number or its name to identify which machines it is used on.
Note: These functions are only available when you have selected a model. The part search will be carried out on all the catalogues on the CD-ROM you are 
using. If you have selected a lawn mower, the search will be carried out in all the available catalogues on CD-ROM "1a").

2.3.1 Search for part number
1. Click on the "search for part number" button.
    The following dialogue box is displayed:

2. Validate by clicking on “OK”. 
The search result is displayed in the form of a table listing all the blocks in catalogues containing the part searched for as well as the corresponding 
model.

Enter the part number 
you

Lines without a button correspond to 
the model currently selected. To view 
the relevant block, click on the blue title 
of the block.

Part number in the block.

Number of the corresponding block.

Click on the button to view the blockfor 
the part catalogue.

Check this box if you want the 
system to use lower 

case/upper case characters.
13
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2.3.2 Search for part name
1. Click on the "Search for name" button. 

The following dialogue box is displayed:

2. Validate by clicking on “OK”. 
If you used the "*" symbol in the name, an intermediate dialogue box appears (see below). All the names matching the criterion entered are listed. Select 
from the names matching your search and then validate with "OK". 

3. The result is displayed directly in the form of a table in the same way as for a search for part reference (See section 2.3.1).

Tip: This search for a name is especially useful when you want to find a machine model by its carburettor number. type the number of the carburettor 
between two "*", in the search field. The result will consist of a table containing the models on which that carburettor is fitted.

Enter the name you require here. 
Note: You can use the ì*î character to 
replace part of the text. For example: 
enter *CARBU* to search for all names 
containing the letters "CARBU".

Check this box if you want the 
system to use lower case/upper 

case characters.
14
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3.  MANUALS, HANDBOOKS AND CIRCULARS

With Global Infotech, you can display various types of documents: user manuals (OM), workshop manuals (SM), workshop manual supplements (SUP), 
fitting instructions (SU), workshop manual updates (SMN) and technical circulars (SB). 
All these documents are in Adobe Acrobat Reader®. Global Infotech therefore uses the Adobe Acrobat Reader® software to display them. This software, 
supplied with Global Infotech, is free of charge and is installed automatically when you install Global Infotech.

3.1 Introduction to Adobe Acrobat Reader®
This software is very simple to use. It allows you to consult and print all the documents included in Global Infotech (except for spare parts catalogues). 
The Adobe Acrobat Reader® software is automatically started up as soon as you select a document in Global Infotech. (See section 3.2). 
By default, when a document is opened under Adobe Acrobat Reader®, the opening page is always the table of contents. Click on the chapter you require: 
the document opens at the corresponding page. Use the Adobe Acrobat Reader® toolbar to move in the document. 
There are two ways of returning to Global Infotech:
1. If you want to leave the current document open so that you can consult it later: use the key combination "Alt" +"Tab" to switch from one software to the 

other or click on the Infotech button in your Windows taskbar (at the bottom of your screen).
2. If you want to close the current document and return to Global Infotech: select "Quit" in the "File" menu under Adobe Acrobat Reader®.

3.1.1 Toolbar

Move the page on the screen

Zoom

Previous page

Next page

100% view

Full page

Select text

First page

Last page

Previous view Search for text

Max. width

Next view
15
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3.2 Searching for a document
Note: You can only search for a document when you have selected a model. The part search is carried out on the catalogues on the CD you are using. (If you 
have selected a lawn mower, the document search window displays all the documents available for the models included on CD-ROM 1a).

1.  After selecting a model, click on the "Documents" button. 
      The "Documents" dialogue box appears:

2. Use the mouse to select the document you require and then validate with "OK". 
Global Infotech then opens the corresponding documents under Adobe Acrobat Reader®. (See section 3.1).

Filters:
Use filters in the same way as 
selecting models (see 
section 2.1) to refine your 
search.
For example: choose the 
type of document to be 
searched for by using the 
"Type" filter and the language 
by using the "Language" filter.
16
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3.3 Direct access to workshop manuals

You can access the workshop manual corresponding to the model selected at any time and at any location in a parts catalogue. Simply click on the 
icon representing a wrench.
If there is more than one document for this model, you are asked to select the desired document in an intermediate dialogue box.

3.4 Direct access to technical circulars
Icons of this type are sometimes displayed under the line following a reference when you consult the spare parts catalogue. These icons indicate that 
a technical circular has been published for the part concerned. Click on this button to access the document. 
Note: These documents are not available in all countries. Please contact Honda to find out whether technical circulars are available in your country.

3.5 Introduction to parts catalogues
In the introduction to a parts catalogue, you will find general information on how to use the spare parts catalogue (colour codes, calculation of repair times, 
etc.).
You can access it by selecting "Introduction" in the "Help" menu. (See section 1.5.4).

3.6 Viewing variation tables
Variation tables are used to view the available options for various types of machine. 
These tables are accessed via the "I" button located in the Global Infotech.
17
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4.  ORDER / ESTIMATE

4.1 "Order form" window
To open the "Order form" window, click on the "Order form" button in the Global Infotech toolbar.
 If you have already selected the parts to be ordered from the parts catalogue section, they will be displayed in this window.

Total excl. VAT

Total incl. VAT

Menu bar

Toolbar

List of parts 
ordered

Display/Hide 
details
18
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4.1.1  Toolbar

 

Details on buttons:
Icon Name of button Function

New Open a new order
Load Load an existing order
Save Save the current order (in directory C:\Infotech\protokoll)
Export an order form Open the dialogue box for the export function (See section 4.8)
New position Add a line manually (labor, oil, accessories and miscellaneous supplies)
Edit position Change the quantity of parts to be ordered
Delete position Delete the selected line
Address Access address books and select the customer for the current order
Order data Specify an order number and add a comment
Order type Specify whether an order is of the "Stock" or "Urgent" type
Shipment type Not used
Print Start the printout of the order
Fax Send the order by fax (This requires fax transmission software)
Part information Access the "Part information" dialogue box (See sections 4.3, 4.4 and 2.2.6)
Calculate Open the calculation window to change the lines, change discount codes or add discounts, etc.

Create a new order

Save

Export

Load an order

Add a line manually

Modify a line

Delete a line

Print …

Fax …

Parts information

Calculate

Modify / change addresses

Order references

Delivery times (Stock / Urgent)
19
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4.2 Setting system parameters

4.2.1 Address book
1. In the "Settings" menu, click on "Order form" (or click on the "Order form" button in the toolbar). 

The "Order form" window is displayed.
2. Select the "Address" submenu in the "Edit" menu (or click on the "Address" button in the toolbar) 

The "Address" window is displayed

3. Click on the corresponding "Addresses" button to display the address input window. 
You can now enter the contact details of your customers and create a complete address book of your customers. (See the next page for details of the 
features of the address book).
Notes :
- Customer addresses and the retailer address are in two different address books.
- When you perform an Infotech update, the address book is preserved.

Tip: If you want to copy the complete address book for the benefit of another user, simply copy file "kunden.adr" located under your directory 
C:\INFOTECH\protokoll and place it in the same location on the desired workstation.

Customer address: 
To select the customer's contact 

details to be indicated on the 
order form or estimate.

Delivery address:
Not used

Supplier address:
Not used

Customer address:
To select the customer's contact 
details to be indicated on the 
order form or estimate.
20
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Data entry form:

Click on "Change" to modify 
an existing sheet.

Click on "New" to add 
a new customer sheet.

"Validation" button: The title of this button 
varies according to the actions performed on 

the sheet. Its general function is to 
validate the current action.

Previous sheet

Use "Search" to find a sheet by means 
of key words.
Example: 
Click on "Search", a blank sheet is displayed. 
In the "Number" field, type the whole 
customer number or just the beginning of it 
(followed by the wildcard character "*"). 
Then click on the validation button. The 
corresponding sheet appears on the 
screen. 
You can use the same method with any 
other field in the sheet, such as the name 
or telephone, etc..

Cancel the current action

Next sheet 

Click on "Delete" to delete a 
customer sheet.
21
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4.2.2 Logo

If you have a logo, you can show it on the order forms or estimates that you print out. To do this, you must have your logo in the form of an image file in "tif" 
format (Tagged Image Format). You then simply specify its location on your hard disk using the "logo" function in the Global Infotech "Settings" menu. (See 
section 1.5.2).

4.2.3 Discount codes (countries concerned)
It is possible to set the Global Infotech parameters so that the system takes discount codes into account. These codes are normally provided with the price 
floppy disk supplied by Honda, independently of Global Infotech CD-ROMs.

Enter your discount codes:

1. Open the calculation window by clicking on the "Calculate" button in the toolbar of the "Order form" window. 
The following window appears on the screen:

2. Click on the "Disc Codes" button (See the illustration above). 
The data entry window for discount codes is displayed.
22
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3. Click on the "Search" button and the system will search your price file for the list of discount codes available.
4. All you have to do then is to complete this window with the information on the discount codes that you benefit from. 

To add a new discount code, click on "New". To modify an existing discount code, double-click on the corresponding line. 

.

Discount for the corresponding code (expressed as %). Markup (expressed as %): 
The markup applied to the recommended retail price to obtain the selling price.

Crate a new discount code

Crate a new discount code Cancel Apply the modifications to the estimate.

Margin (expressed as %): 
The profit margin as a % between the selling price 
and the buying price.

Search: Searches your price file for the list of discount codes 
available. 
NOTE: that the search process may take a while to complete 
(a number of minutes). 

Discount codes:
This column includes the discount codes 
that you have entered.

IMPORTANT: 
Code "!" (default discount code) is used 
to specify a default discount / markup / 
ma gin to all parts that do not appertain to 
any specific discount group or to any part 
appertaining to a discount group for which 
no discount percentage has 
been defined.

Discount code

Margin (%) between selling and buying price

Discount (%) corresponding to Honda discount 
code granted to the retailer for the purchase of 
parts

NOTE: 
The Markup and Margin fields are linked. You can 
therefore enter either a markup or a margin

Markup (%) applied to recommended retail price
23
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4.2.4 VAT rate

Select "Value added tax" in the "Order form" dialogue box in the "Edit" menu.
The next dialogue box appears. Enter the VAT percentage in force in your country.

Validate with "OK".

4.2.5 Installing the price CD-Rom
A price CD-Rom will be supplied by Honda each time price rates are updated. Proceed as follows to update Global Infotech with the CD-Rom:
1. Insert the CD-Rom in your CD-Rom drive.
2. On your Windows desktop, double-click on the "Workstation" icon located in the top left corner of your screen. 

A new window appears.
3. Double-click on the icon representing your CD-Rom drive.

4. In the window listing the contents of the CD-Rom, double-click on file  .

The new prices installation window is displayed on the screen:

5. Click on the "Next" button to install the CD-Rom.
6. A new window will be opened to indicate that the installation has been completed. Then, click on the "Finish" button.

Currency used
Date as from when these prices 
are valid

NOTE: 
When this is a value containing 
decimals, the separator used must 
be a comma and not a point.
24
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4.3 Adding parts to an order
There are several ways of selecting parts to be ordered:

• If you want to order a lot of parts:
You can switch to Ordering mode by clicking on the "Ordering" button    in the Global Infotech toolbar.
As long as you are in Ordering mode, the cursor changes to a "V" shape whenever you pass over a part number or a part index in a drawing. All you need 
to do is to click on the left mouse button to order the relevant part.

• If you want to order only a few parts:
click the right mouse button on the corresponding part reference or index in the drawing. The context menu is displayed (see section 2.2.5). Then select 
"Ordering".

• If you already know the part reference to be ordered:
click on the "Part information" button   .  A new dialogue box opens and this must be used to enter the part number to be ordered. (The part number must 
always be typed without dashes). Validate with "OK". The part information window opens, showing the price of the relevant part and any personal notes. To 
order the part, click on the "Select" button after modifying the quantity as required (the default quantity being 1).

4.4 Searching for a part price
The prices of parts are displayed in the "Part information window".

This window can be opened in two ways:

• If you already know the part number:

Click on the "Part information" button . A dialogue box opens and this must be used to enter 
the part number to be ordered (always typed without dashes and in capitals). Validate with "OK" 
to open the part information window.

IMPORTANT: The part number must always be typed WITHOUT DASHES

•  If you are consulting the parts catalogue:
Click the right mouse button on the part. The context menu is displayed (See section 2.2.5). 
Select the "Part information" menu.
25
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4.5 Calculation window (Not available in the United Kingdom)

It is opened by clicking on the "Calculate" button   in the toolbar of the "Ordering" window.

Discount code

Buying price

Recomm. 
retail price

Selling price

Discount 
(%)

Price Margin (%)

Qty Total

Currency used

Show / Hide Close

Total incl. tax

Order total excl. tax 
and excl. total discount

Total discount (%)

Total excl. tax

VAT

Total margin as 
percentage

Total selling price

Total buying price

DescriptionPart number

CancelDiscount codes
26
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Columns:
• Part No.:
Part numbers ordered

• Description:
Part description

• Discount codes:
An exclamation mark (!) located to the right of a discount code means that the code has not been defined by the user. This therefore implies that the general 
discount code will be assigned to it by default. (See section 4.7.2.).

• Buy price: (Displayed in detailed mode only)
The buying price is the retail price recommended by Honda after application of the discount granted to the retailer (discount code).

• Recommended retail price: (Displayed in detailed mode only)
Retail price recommended by Honda.

• Sell price:
Selling price recommended by Honda after applying the sales margin or markup via the discount code. (See section 4.7.2).

• Disc. %:
Special discount (%) per line.

• Price:
Selling price after applying the special discount.

• Margin: (Displayed in detailed mode only)
Margin expressed as % taking into account the special discount.

• Qty:
Quantity of parts.

• Total:
Total amount per line.

Buttons:
• Disc Codes:
Accesses the dialogue box to add and modify discount code parameters (see section 4.2.3).

• Hide / Show:
Hides or shows the "Buy price", "Recommended retail price" and "Margin" columns as well as the information on the total margin and the total buying price.

• Close: Closes the current calculation window.
• Cancel: Closes the current window and cancels all of the operations performed.
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4.6  Editing an order
Open the "Order form" window by clicking on the "Order form" button in the Global Infotech toolbar. (See section 1.4).

4.6.1 Adding a line manually

Click on the "Part information" button  in the "Order form" window toolbar.
Enter the part number and the desired quantity in the following dialogue box:

4.6.2 Deleting a line
Select the line to be deleted by clicking on it. 
Click on the "Delete position" button. 
A dialogue box asks you to validate your choice: click on "Yes" to delete the line or "No" to cancel.

4.6.3 Modifying a line
The only parameter that can be modified with this function is the "quantity of parts to order".
The quantity ordered can be modified in the following two ways:
- Double-click on the line concerned.
- Click on the "Edit position" button in the toolbar in the "Order form" window.
Enter the desired quantity and validate with "OK".

NOTE:  
The part number must 
ALWAYS be typed without dashes.
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4.7 Editing an estimate or an invoice

4.7.1 Adding labour / minor supplies / accessories, etc.. ("Order form" window) 
Click on the "Add" button in the Calculation window. (See section 4.5.). 
In the window that is displayed, you must enter the title of the product or service invoiced, its price, the quantity, the special discount rate and the VAT rate to 
be applied. The total is calculated automatically. 
Validate with "OK". 
A new line is then added to the list of parts ordered.

IMPORTANT: Always fill-out  "Part Number" field with one "-" sign while adding labour, supplies or accessories. 

Note: You can add as many lines as you wish.

4.7.2 Applying a discount or markup to a part ("Order form" window) 
To modify the parameters for a part, simply click on the corresponding line. 
The following window appears:
Enter your changes and validate them by clicking on "Update".
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4.7.3 Applying a total discount to an estimate ("Calculation" window)

To add a discount to the total amount of an estimate or invoice, you simply specify the value as a percentage in the "Total discount" field in the "Calculation" 
window.

4.7.4 Displaying estimates ("Calculation" window)
There are two possibilities:

1. Your country is a member of the European Union:
In this case, the currency used by default is the euro.
The prices displayed in the order window are only available in euros. 
These prices can only be converted into your local currency in the Calculation window, by using a dropdown menu. (See section 4.5).

2. Your country is not a member of the European Union:
In this case, only your local currency is used.

4.7.5 Saving orders and estimates / invoices ("Order form" window)
• Orders and estimates/invoices are saved in the "Protokoll" subdirectory under the "Infotech" directory. The corresponding files have the file extension "pro".
If you want to exchange these orders or estimates between a number of computers, all you have to do is to copy the desired files into the directories specified 
above on the destination computer.
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4.8 Exporting an order
The data contained in an order can be exported in the form of files. Those data can then be used in a stock management system. Data can also be exported 
in "OLO" format(*). 
 
(*)"OLO" (On-Line Ordering system) is a software package developed by Honda. It lets you transmit your part orders via a modem link by using orders 
created with Global Infotech and exported in "OLO" format.

4.8.1 Export window

To open the export window, click on the "Export order form" button   .

Export directory:
Path for the directory the data will be 
exported to
Click on the "Modify" button" to 
change the destination directory.
IMPORTANT:  
If you use the OLO system to place 
your orders, do not modify the export 
directory path. If you do, OLO will no 
longer be able to access the order to 
be sent.

Export interface: 
Select the desired type of export here.

Cancel: 
Click here to return to the order form 
without exporting your data.

Data export: 
Click here to export your order.

Data format:
To export data in DOS/WINDOWS 
format or in UNIX format.
31



Honda Global Infotech 

4.8.2 Different export formats

"Parts link" : Standard file format recognized by a great many stock management systems.
"WIPAS" : Not used.
"Honda-OLO" : Exports your orders in "OLO" format. (See section 4.8).

4.8.3 Exporting in "OLO" format
To export your orders in "OLO" format, select the "Honda-OLO" export type in the Export window and validate by clicking on the "Data export" button.
The following window appears:

 

Enter your country code 
here (See table below).

Enter your Honda dealer 
code here (supplied by 
Honda).

Not used. Leave this field 
blank.

Retailer number

Order type:
Enter the type of order 
placed here: 
Urgent = Urgent 
Stock = Normal

Customer No.:
Customer number: The customer No. 
selected in the order window is 
automatically displayed in this field. 

Backorder:
Yes: Indicates, in the order, that Honda 
must take the backorder into account.
No: Indicates, in the order, that Honda 
must not take the backorder into account.
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Enter the following codes in the "Customer number" field:

First field: your country code

Second field: your customer code

This code is supplied by Honda.
 
Note: Once you have entered these codes, you need not enter them again (as they are saved automatically).

Click on "OK" when you have entered the information required.
The dialogue box appears to inform you that your order has been exported.

IMPORTANT: The fact that an order has been exported does not mean that it has been transmitted to Honda. It only means that your order is ready to be 
processed by the On-Line Ordering system (OLO).

Code Country
240 F
250 B
231 NL
261 D
201 GB
224 CH
272 A
284 I
256 SK
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4.9 Printouts
From the "Order form" window, select the File/Print menu. Five kinds of printouts are available for you to use: 

1. Estimate with discount:
The printout includes the following fields: 
Part number, Description, Quantity, Price, Discount, Sale price, Total, Overall discount (if different from 0), Remarks, Dealer's address, Dealer's logo, 
Customer's address, VAT number, Date, Estimate number.

2. Estimate without discount:
The printout includes the following fields:
Part number, Description, Quantity, Sale price, Total, Overall discount (if different from 0), Remarks, Dealer's address, Dealer's logo, Customer's address, 
VAT number, Date, Estimate number.

3. Invoice with discount:
The printout includes the following fields:
Part number, Description, Quantity, Price, Discount, Sale price, Total, Overall discount (if different from 0), Remarks, Dealer's address, Dealer's logo, 
Customer's address, VAT number, Date, Invoice number.

4. Estimate without discount:
Part number, Description, Quantity, Sale price, Total, Overall discount (if different from 0), Remarks, Dealer's address, Dealer's logo, Customer's address, 
VAT number, Date, Invoice number.

5. Order form:
Part number, Description, Quantity, Sale price, Total, Remarks, Dealer's address, Dealer's logo, Customer's address, VAT number, Date, Order number.

6. Detailed printout:
All of the fields available in the detailed view of your order.
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